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Documenting Hazards Overview 

In this lesson, you will create an ArcGIS QuickCapture project to help field workers document hazards of different types while 

out in the field. You will create and share a simple project for users to locate, categorize and take a photo of hazards with the 

ArcGIS QuickCapture mobile app. 

• Publisher or Administrator role in an ArcGIS organization 

• ArcGIS QuickCapture 

• A smartphone or tablet with Android 5.0 or later or iOS 11 or later 
 
 

 

https://www.esri.com/en-us/arcgis/products/arcgis-quickcapture/overview
https://www.esri.com/en-us/arcgis/products/arcgis-quickcapture/overview
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Create ArcGIS feature service 

In this lesson, you’ll create a new hosted feature layer using a feature layer template from ArcGIS Online. 

https://community.esri.com/community/arcgis-quickcapture/blog/2019/06/26/arcgis-quickcapture-hazards-project-tutorial 

Create layer 

Before you can send your field crew to document hazards in the field, you need to create a hazards layer for them to edit from. 

1. Sign in to your ArcGIS organizational account by going to arcgis.com and logging in with credentials provided by your 
organization. 

 
2. At the top of your organization home page, click Content. 

 

 
 

The content page stores all the layers, maps and apps that you own in your ArcGIS Online organization. This is where 

you’ll create your Hazard feature service. 

3. Under the content ribbon, click Create and choose Feature Layer. 

 

 
The Create a feature layer dialog appears. This is where you can select from a variety of feature layer templates. These are 
hosted layers with pre-defined schema and symbology. They’re empty and editable. So, you can get people into the field 
faster! 

4. In the Search box, type Hazards and select the Hazards feature layer template that appears. 

 

  
 

The Hazards side panel appears, with some additional information on the feature layer template. 

5. Click the Create button. In the next dialogue, click Next and then click Next again. 
 

 

https://community.esri.com/community/arcgis-quickcapture/blog/2019/06/26/arcgis-quickcapture-hazards-project-tutorial
https://www.arcgis.com/home/signin.html
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The final dialogue appears, where you’ll specify a title, tags, and summary for your new hosted layer. 

6. For the title, type Hazards_yourinitials. 

7. The tags should already have, Hazards, Threats, Safety, Violence. 

8. For the summary, type feature service to collect locations of hazards. 

 
 

9. Click Done, once you’ve entered information about your layer 

The item details page for your new feature service will open. This is where you can access information and update settings 
for your feature service. 

 

Configure feature service 

Next, you'll get the feature service ready for the field by adding additional features. Then, you’ll enable editing. 

Make sure you are still on the item details page of your new feature service. Click on the Data tab. 

This gives you a table view of fields currently in your feature layer. These fields will store information about documented 
hazards. Next, you’ll add new fields that will automatically populate in the ArcGIS QuickCapture mobile app. 

1. Above the table view to the right, click Fields. 

 

A detailed view of the fields opens. This is where you can access additional information about your fields and add new 
ones. 

2. On the top left of the page, click the Add button.  
The Add Field dialogue opens, next you’ll add information for a new field 

3. For Field Name, type HA. 

4. For Display Name, type Horizontal Accuracy. 
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5. For Type, select Double. 

6. Click Add New Field to close the dialogue. 

 

You’ve just added a new field to store the horizontal accuracy of hazards when documenting them in the field. Next, you’ll 
add another field to store time information. 

 

7. Click the Add button. 

8. For Field Name, type TimeCaptured. 

9.  For Display Name, type Time Captured.  

10.  For Type, select Date. 

11. Click Add New Field to close the dialogue. 

You’ve just added a new field to store the exact time when an observation is made in the field. Next, you’ll apply settings to 
the hazards feature service that will enable editing capabilities. 

12.  Click the Settings tab, at the top right of the page. 

13.  Make sure edit settings reflect the screenshot below: 

 

 Before creating the QuickCapture Project, you’ll look at your new feature service in the Map Viewer. 
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14.  Click on the Overview tab. 

15.  Click Open in Map Viewer. 

This will load your empty feature service into the Map Viewer. 

16.  Click on the Legend to display the predefined categories in your layer. 

 

Next, you’ll save the map so you can return to it at the end of the lesson to view results. 

17.  Click Save. 

18.  For the title, type Hazards map_your initials 

19. For the tags, add Hazards 

20. For the summary, type A map of Hazards captured in the field. 

 You have just completed the configuration of an empty feature service to document hazards while in the field. Next, you’ll 
learn how to configure an ArcGIS QuickCapture project. 
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Configuring ArcGIS QuickCapture Project  

Now that you've configured the hazard feature service, you'll use it to configure a project using QuickCapture designer. 

1. Navigate to https://quickcapture.arcgis.com and login with your ArcGIS credentials. 

2. Click the New Projects button. 

3. Select the new feature layer you just created and click Next. 

Before you can create your project, you’ll add basic information like a title, tags and a data-recover email.  

 
4. For the title, type Hazards. 

5. For the data recovery email, type your email address. 

6. Click Create. 

Your hazard feature service gets loaded into the ArcGIS QuickCapture designer. By default, a button gets created for each 
hazard type. Next, you’ll change some of the characteristics of your buttons as well as their data behavior.   
 

7. Click on the Hazard group name. 

 

The group properties open in the right side panel.  

8. Change the Number of columns to 2. 

9. Click the Road Not Passable button. 

10.  On the right-side panel, click the Data section. 

11.  To the right of Take photo toggle the button to enable photo capture. 

 

 

 

https://quickcapture.arcgis.com/
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Remember the fields you added? Horizontal Accuracy and Time Captured. Before you complete the project you’ll set these 
variables for each hazard type. 

12.  Make sure the Road Not Passable button is still selected and the Data section is open in the side panel. 

13.  Under Horizontal Accuracy, for value type select Device variable and select Horizontal Accuracy (m). 

14. Under Time Captured, for value type select Device variable and select Capture time (UTC). 

 Note: If you do not see the fields, scroll down in the right-side panel to see full list of captured fields. 

 

15.  Complete the same process for the remaining 7 hazard types. Enable photo capture (optional) and set the values for 
Horizontal Accuracy and Capture Time. 

16.  Click Save at the top right of your screen. 

You have just completed the configuration of your first QuickCapture project. You can make additional changes with ArcGIS 
QuickCapture designer at any time. 
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Sharing your ArcGIS QuickCapture project 
All ArcGIS QuickCapture projects are stored in your Content page within your ArcGIS Organization as a dedicated ArcGIS 
item type (the ArcGIS QuickCapture project item type). Next, you’ll share your new Hazards QuickCapture project so it can 
be used by people in the field. 

 

1. In a new tab in your browser, return to https://www.arcgis.com and ensure you are still signed in with your ArcGIS 
Online credentials. 

2. At the top of the page, click Content. 

3. Select your hazards Feature Layer and hazards QuickCapture Project. 

4. Click, share and under set sharing level select Organization. 

 
 

Document hazards 

Previously, you created and then shared a QuickCapture project. Next, you'll use the ArcGIS QuickCapture to document 

Hazards in the field. 

(If you haven’t already) Download ArcGIS QuickCapture 

First, you'll download ArcGIS QuickCapture as a free app on your smartphone or tablet. QuickCapture allows you to 

remotely capture features. Because it can be accessed from a mobile device, field workers can input information on 

hazards directly into your GIS, eliminating pen and paper from the process. 

1. On your smartphone or tablet, find ArcGIS QuickQuickCapture on Google Play or the Apple App Store (for iPad and 

iPhone). 

 Note: Your experience may differ depending on whether you use the Android or iOS. 

The steps and images here are for QuickCapture on an iPhone. 

2. Download and install the free app. 

 

Open the project 

Next, you'll open the Hazards project in ArcGIS QuickCapture. 

1. Open ArcGIS QuickCapture on your mobile phone or tablet. 

2. If you aren't signed in, sign in to your ArcGIS organizational account. 

After you sign in, the app opens to My Workspace. If you’ve used ArcGIS QuickCapture before, this is where you will see 

already downloaded projects. You probably don’t see your Hazards project because you have not downloaded it to your 

device yet. Next, you’ll download and open your project. 

3. At the bottom right of your screen click the plus button and select Browse Projects 

4. Tap the download icon next to your Hazards project. 

The Hazards project will be downloaded to your device. Once the download is finished you can begin capturing Hazard 
locations. 

5. Tap the x in the top left to return to My Workspace 

 

https://www.arcgis.com/
https://play.google.com/store/apps/details?id=com.esri.arcgisquickcapture&hl=en_US
https://apps.apple.com/us/app/arcgis-quickcapture/id1451433781
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You should see your downloaded Hazards project listed. 

6. Tap on the Hazard graphic to open the project. 

You can see all of the Hazard types listed. These are all interactive buttons.  

7. Explore the project by selecting different Hazard buttons.  

When you select a button, the location, hazard type, horizontal accuracy, and time captured is all logged and sent back to 
the feature service where it is stored. 

 

View Results 

You just documented the location of Hazards in the field with the ArcGIS QuickCapture mobile app. Now, you’ll use the web 
map you created at the beginning of the lesson to view the results. 

1. Return to your Content page. 

2. Open the map titled Hazards Map_yourinitials. 

The map opens. If you do not see hazards on the map, try doing a location search for your current location. 

3. Click on one of the Hazards on the map to get it’s pop-up information. 

 

 
In this lesson, you enabled a hazard documentation process from a paper form to a digital one. First, you created and 

configured a feature service using a template in your ArcGIS Online organization. Then, you built an ArcGIS QuickCapture 

project around the feature service and ArcGIS QuickCapture mobile app to gather hazard locations in the field. The hazards 

you added was automatically updated to the feature service.  

You can find more lessons in the Learn ArcGIS Lesson Gallery… learn.arcgis.com/en/gallery. 

 

http://learn.arcgis.com/en/gallery/
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Reporting Water Violations Overview 
 
This exercise should take 20 – 30 minutes and will guide you through the creation of a survey form using the 
Survey123 website’s Web Designer.  We will be creating a simple form to report a city code violation. To do this 
exercise, you will need: 

• Publisher or Administrator role in an ArcGIS organization (get a free trial) 

• A mobile device or tablet with the Survey123 mobile app installed 
 
 

 

https://www.esri.com/en-us/arcgis/trial
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Create a survey 
1. In a new web browser tab, navigate to: https://survey123.arcgis.com 

2. Sign into Survey123 with your ArcGIS Online organization account (if not already) 

3. On the Survey gallery page, click Create New Survey > Using the web designer (Get Started) 
 

 

4. In the Create New Survey dialog that appears, provide a title, tags, and summary – you can optionally add a 
custom thumbnail 

for a title, “Water Waste Report” 

for tags, “water” and “survey123” 

5. Click Create 
 
The survey creation process may take a minute or so because behind the scenes, a new form item and associated 
feature layer are being created in ArcGIS Online. When the survey is made, you will see the survey design page and it 
should appear blank. 
 

 

https://survey123.arcgis.com/
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On the left side of the design page is the survey layout preview, on the right side are the options available to you to 
author your survey. There are 4 tabs in the right configuration panel (from left to right): 

• Add – select the type of question you want to add to the survey; 

• Edit –  edit the properties of a survey question; 

• Theme – defines the appearance of your survey; 

• Settings – enables you to configure a ‘thank you’ message after the survey is submitted. 
 
 

Adding Questions 
You will create as Water Waste Violation report with 8 questions.  
 

1. From the Add tab, select the Date question and drag it onto your survey layout on the left. 
 

Notice that the survey question now appears on the survey layout. By default, it is untitled. You can configure the 
properties for the question under the Edit tab. 

 

2. Select the date question on the survey layout, then select the Edit tab. 
 

 
 

3. On the Edit tab, for the Label input, type “Violation Observation Date:”  
 

Observe that as you input the label, the information is reflected on the survey layout. Many different parameters 
can be configured for each survey question, depending on the type of question. In this case, you can further 
control the default dates and validation rules. 

 

4. On the Edit tab, under Default Value, select the Submitting date option and under Validation, check the This is 
a required question checkbox.  

 

5. To add another survey question, return to the Add tab. Select the Dropdown question and drag it into the 
survey below the Date question. 
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6.  This will hold the type of water violation, so label it “Type of Violation:”.   
 

The Dropdown allows the person to fill in the form by selecting one of several values. On the Edit tab, just above 
the list of choices, there is a link called ‘Batch Edit’. This allows you to put the choices in one after another and is 
useful when you have lots of choices.  

 

 
 

7. Click on the Batch Edit link and input the following choices (note you can copy/paste from this doc directly into 
Survey123): 

Overwatering 
Broken sprinkler 
Time-of-day violation 
Assigned day violation 
Fountain/Water feature violation 
Broken pipe or leak 
Misting system violation 
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8. After entering the choices, click OK. The entries will now appear in the choices section: 
 

 
 

9. Next, we want to give the respondent a field to provide more details on the violation. For this, we’ll use a 
Multiline text input and create a question called “Notes”.  Both the multi-line and single-line text inputs provide 
a free form text area; while this may make the analysis of the survey data more difficult (due to variations in 
phrasing and terminology), it is helpful to record specifics that we do not know beforehand.  

 

10. From the Add tab, select the GeoPoint question and drag it onto your survey layout. Ensure that you position it 
underneath the Dropdown question you just added.  

11. Activate the Edit tab, for Label type: “Location” 

12. Define the default spatial extent of the map by clicking it and navigate to your current location. 

13. Make the question Required 

14. Let’s save our progress by clicking the Save Button at the bottom of the right side.   
 

Saving is useful if you are planning to make several changes and want to ensure you preserve the existing design. 
 
Survey123 forms support using a smartphone’s camera to take pictures that accompany the form; in ArcGIS, these 
are stored as geodatabase attachments. 
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15. Add an Image question and label it “Photo of Violation”. 
 
The next section concerns who committed the violation.  

16. Add a Single Choice question. Label it as Is the offender present?  and set its choices to Yes and No 

17. Add a Group into the form and set its label to Offender details. 

18. Add the following questions within the group: 
A singleline text question for the Name. 
An email question for their Contact e-mail. 
A signature question for their Signature. 

 

19. Select the “Is the offender present?” question and click on three-pronged arrow in the lower right of the 
question box. This will let us set a rule based on the answer to this question. 

20. In the box that appears, set up the following rule: 
If “Yes”, Show “Offender details”, then click OK. 

 

21. We’ve completed the form. Save it again. 

 

Publish & Share a Survey 
 
Before publishing the form, let’s preview it. 
 

1. At the bottom of the right configuration pane, click the ‘Preview’ Button. 
 
You can preview how the form will look in a desktop monitor, tablet or a phone-sized screen. The form should have 8 
questions. 
 

2. Once done previewing, click on the “X” button to close the preview. 

3. To publish the survey, click the “Publish” button at the lower right; dismiss the message dialog by clicking OK. 

4. Click Publish at the lower right. 
 

 
 
The process may take a minute, you will see a “Publish Successfully” message window appear when it’s done. 
 

5. After publishing, click on the “Collaborate” tab.  
 
In this dialog, you can share the survey to specific groups, the organization, or everyone; this will determine who can 
submit data to the form.  You can also get URL links and barcodes to help end users open your survey. 
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6. While keeping the Open the survey in browser directly option selected, copy the survey link and paste it into a 
new browser tab. The survey will open. Complete and submit a survey from your web browser. 

 

 
 

7. Switch the link option to Open the survey in the Survey123 field app directly and copy the link again. Open the 
link from your mobile device and submit data using the Survey123 mobile app. 

 

 
 
 

8. Switch to the Data tab to explore records submitted to your survey. 
Explore filtering options 
Explore export options 
Click on the records in the table to open the Individual Response report 

9. Switch to the Analyze tab to understand trends in the data submitted to your survey. 

 
In this lesson, you created a Survey to report water violations using the Survey123 for ArcGIS Web Designer. The Survey is 

accessible via web browser and mobile app. You then analyzed the results which are updated in near real-time. 

You can find more lessons in the Learn ArcGIS Lesson Gallery… learn.arcgis.com/en/gallery. 

http://learn.arcgis.com/en/gallery/
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Inspect Hydrants Overview 

Naperville, Illinois, is converting its fire hydrant inspection reports from paper to tablets. In this lesson, as a GIS manager in this 

Chicago suburb, you'll work with inspection data in ArcGIS Online in the form of a web map you can share directly with your 

workers. While your inspectors are on location, they'll update their hydrant reports directly to the map. 

• Publisher or Administrator role in an ArcGIS organization 

• Collector for ArcGIS 

• A smartphone or tablet with Android 4.2 or later or iOS 11 or later 

https://www.esri.com/en-us/arcgis/products/collector-for-arcgis/overview
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Create a map for inspections 

In this lesson, you’ll add an existing ‘hydrants’ layer to a web map in your ArcGIS Online Organization. Then, you'll configure 

the layer's pop-up to show inspections in chronological order. Finally, you'll share your layer and map so your workers can 

access them. 

Add the layer to a map 

Before you can send your field crew to inspect hydrants, you need to add your hydrants layer to a web map. 

1. Sign in to your ArcGIS organizational account by going to arcgis.com and logging in with credentials provided by your 
organization. 

 
2. At the top of your organization home page, click Map. 

 

 
A new map opens. The map extent for a new map is set to the default extent of your organization. Next, you'll search for 

and add a hydrants layer. 

 Note: If you're in a new ArcGIS Online session, clicking Map opens a new map. Otherwise, it 

opens the last map you were using. If an existing map opens, click New Map in the 

upper right corner of the page and choose Create New Map. 

3. On the ribbon, click Add and choose Search for Layers. 

 

 
The Search for Layers pane appears. 

4. In the Search pane, click the My Content drop-down arrow and choose ArcGIS Online. 

5. In the Search for layers dialog box, type Hydrants_Workshop2020. Press Enter to initiate the search. 

 

 
 

The search returns the Hydrants_Workshop2020 layer. This layer contains point features that will display the location of 

each hydrant. 

https://www.arcgis.com/home/signin.html
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6. For the Hydrants_Workshop2020 layer, click the + Add button. 
 

 
 Note: Your default extent may differ from the example depending on your monitor size and 

resolution.
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In the Contents pane are four items: the Hydrants_Workshop2020 layer; the Topographic basemap; and the Inspections and 

Violations tables. Their layer names are a little confusing, however. You'll change them to something more readable before 

continuing. 

7. Point to the Hydrants_Workshop2020 layer. Click More Options and choose Rename. 

 

 
8. Rename the layer Hydrants and click OK. 

9. Rename the Hydrants Workshop - Inspections table to Inspections. Rename the Hydrants Workshop - Violations 

table to Violations. 

 

Configure the layer's pop-up 

Next, you'll configure the pop-up of the Hydrants layer to show data from the Inspections table. You'll adjust the pop-up's sort 

options so inspections appear in chronological order. 

1. Zoom in on the map so that individual hydrant features become distinguishable. Click any hydrant to view its pop-up. 

 

 
The pop-up shows the attribute information of the Hydrants layer. The formatting is good enough, but there is some 

information your workforce won't need to see. You also want to make sure you can access related inspections for each 

hydrant through the pop-up, although currently those tables don't have any records (you'll add records in the next lesson). 

2. Close the pop-up. 

3. In the Contents pane, point to the Hydrants layer. Click the More Options button and choose Configure Pop-up. 

4. For Pop-up Title, type Facility ID: (including the trailing space) before the field value to give it context. 
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5. In the Pop-up Contents section, below the list of field attributes, click Configure Attributes. 

6. In the Configure Attributes window, in the Display column, uncheck OBJECTID and GlobalID and click OK. 

 

 
At the bottom of the Configure Pop-up pane are options for showing related data. Show related data is checked by 

default. There are also options for how related data is sorted. 

7. In the Related Data section, click Sort Options. 

 

 
The Sort Options window opens. You'll sort the inspections data chronologically. 

8. For Field, choose Inspection Date. For Order, choose Ascending. 

 

 
9. Click OK in the Sort Options window. At the bottom of the Configure Pop-up pane, click OK. 

10. Click any hydrant to view its updated pop-up. 
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Save and share the map 

Now that you've created the map, you'll save and share it. To ensure you share it only with your field workforce, you'll create a 

group to which you can invite specific members. 

1. On the ribbon above the map, click Save and choose Save As. 

 

 
2. For the title, type Hydrant Inspections and Violations. 

3. For the tags, add hydrants, inspections, violations, Naperville, and Illinois. 

4. For the summary, type A map of fire hydrants and hydrant inspection information in Naperville, 

Illinois. 

 

 

5. Click Save Map. 

The name change is reflected on the map. Now that your map is saved, you'll share it with your workforce. First, you'll exit 

the map and create a group. Groups allow you to choose who sees the group's content, so you can ensure only your 

workforce has access to the information. 

6. At the top of the map, click the Home menu and choose Groups. 
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The Groups page opens, which shows the groups (if any) of which you are a member. 

7. Click Create group.  

 

 
A new page opens, allowing you to set the parameters of your group. 

8. Name your group Naperville Hydrant Inspectors. For the summary, type Content for hydrant inspectors 

in Naperville, Illinois. Add search tags that describe the group's content and geography, like the ones you used 

for the map. 

 

 
    Tip: You can drag or upload a thumbnail image. Good ideas for thumbnails are logos or 

crests of the town or department with which the group is associated. You probably 

don't have the Naperville city crest, so you can leave the thumbnail blank. 

9. For Who can view this group, click Only group members. 
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By making your group private, only users you invite can join and view the group's content. Accept the default for the 

remaining questions. 

10. At the bottom of the page, click Create Group. 

The group is created. It has no items and no members other than you. If you want to invite members to the group, click 

Invite Users at the top of the page. 
 

    Tip: If using ArcGIS Online, you can invite members both inside and outside of your 

ArcGIS Online organization. As long as your field inspectors have ArcGIS Online 

accounts, you can invite them to your group. 

Next, you'll share your web map with the members of the group. 

11. At the top of the page, click Content. 

12. Check the Hydrant Inspections and Violations web map. Click Share. 

 

 
13. In the Share window, check the Naperville Hydrant Inspectors group. 

 

 
14. Click OK. 

15. On the ribbon at the top of the page, click Groups. Click your Naperville Hydrant Inspectors group. 

The web map and Hydrants layer are now accessible through the group. 

 
You've created a web map to collect inspection records and shared the map with your field workforce. 
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Inspect a hydrant 

Previously, you created a map to collect hydrant inspection information. Next, you'll use Collector for ArcGIS to test how your 

map functions in the field by adding an inspection and a violation to a hydrant feature. 

(If you haven’t already) Download Collector for ArcGIS 

First, you'll download Collector for ArcGIS as a free app on your smartphone or tablet. Collector allows you to remotely edit 

data in a shared map. Because it can be accessed from a mobile device, field workers can input the results of their on-site 

inspections directly into your GIS, eliminating pen and paper from the process. 

1. On your smartphone or tablet, find Collector for ArcGIS on Google Play or the Amazon Appstore (for Android devices), the 

App Store (for iPad and iPhone), or the Microsoft Store (for Windows 10 devices). 

 Note: Your experience may differ depending on whether you use the Android, iOS, or 

Windows version of Collector. The steps and images here are for Collector on an 

iPhone. 

2. Download and install the free app. 

 
Open the map in Collector 

Next, you'll open the Hydrant Inspections and Violations map in Collector. 

1. Open Collector for ArcGIS on your mobile phone or tablet. 

2. If you aren't signed in, sign in to your ArcGIS organizational account. 

After you sign in, a list of your maps opens. If you have only a few maps, the Hydrant Inspections and Violations map may 

be easy to locate in the list. If you have many maps, it may be more difficult. In case the map is not easy to locate, you'll 

access the map through the Naperville Hydrant Inspectors group. 

3. Scroll to the bottom of the list of maps to see your groups. 

Note: For Android users, tap the Menu button to view your groups. 

https://play.google.com/store/apps/details?id=com.esri.arcgis.collector
https://www.amazon.com/esri-inc-collector-for-arcgis/dp/b00x8t73be
http://links.esri.com/collector-aurora-appstore
http://links.esri.com/collector-aurora-appstore
https://www.microsoft.com/en-us/p/collector-for-arcgis/9wzdncrdg7lk?rtc=1&activetab=pivot%3Aoverviewtab
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4. Tap Naperville Hydrant Inspectors. 

A list of maps in that group opens. Only the Hydrant Inspections and Violations map is in the group, so it is the only map 

listed. 

 

 
5. Tap the map to open it. 

If you have location services turned on, the map opens to your current location, regardless of the map content. You're 

probably not in Naperville, so you'll navigate there. 

6. Tap the Search button. 

7. Type Naperville in the search bar and tap Search. 
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Naperville, Illinois, is the first search result. 

8. Tap the result for Naperville to zoom to the center of the city. 

 

 
9. In the panel at the bottom of the map, tap the close button to close the search results and tap Cancel in the search panel to 

close it. 
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Add an inspection to a hydrant 

Now that you've opened your map and navigated to Naperville, you'll perform a mock inspection of a hydrant. 

1. Tap any hydrant on the map. 

The tapped hydrant is selected on the map. A panel opens, showing information about the hydrant. 
 

Note: For Android users, tap a hydrant once to select it, then tap the pop-up to expand it. 

 

 

2. Scroll the panel to view more of the hydrant's details. 
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The details include the information in the feature's attributes and actions you can take with the feature. Below the attribute 

information and before the actions is a section titled Related that includes inspections. For Android users, under the 

Inspections section, you will see options to View an inspection or to add a New inspection. 

3. Tap Inspections to view existing related inspection records or create new ones. 

 

 
The panel shows a button to add an inspection as well as a list of inspections related to the hydrant you've tapped. Since 

there aren't any inspections yet, none are listed. 

4. Tap Add. 

 Note: For Android users, under Inspections, tap New. 

The Inspections form opens. It contains the fields in the Inspections table. Swipe up to view the form full screen. 



Inspect Hydrants 

Copyright © 1995-2019 Esri. All rights reserved. 17 

 

 

 
 

 

 
 

5. Tap the Pressure (PSI) field. 

The field becomes editable. 

6. Enter a value of 60 (a standard PSI value for fire hydrants) and tap Next. 

7. Add data to the other fields. (You may have to scroll down to see some of the fields, including Inspection Date.) 
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This is a test, so the values you add aren't important. Most fields require only a yes or no. When you add an inspection 

date, the title of the form changes to include it. 

8. Tap Submit to send the updates. 

 Note: For Android users, tap the checkmark button to save your inspection and return to the 

hydrant's details. 

You return to the map. The hydrant feature is still selected and the new inspection form is displayed. 

9. Close the inspection form, and close the Inspections panel to see the hydrant's details again. Scroll down to the Related 

section and tap Inspections to view the inspections on the hydrant. 

 Note: For Android users, under Inspections, tap View. 

The inspection appears as part of a list, marked by its date. If you add more inspections, they will be organized 

chronologically. 
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Add a violation to your inspection 

You published your hydrants layer to also include a table for violations observed during inspections. The Violations table does 

not have a direct relationship to the Hydrants layer, but it is indirectly related to it through the Inspections table. Next, you'll add 

a test violation to the hydrant. 

1. On the list of the hydrant's inspections, tap the inspection you just added. 

 

 
The inspection's form and available actions display in the panel. All of the values you inputted for the inspection are shown. 

Below the attribute information and before the actions is a section titled Related that includes violations. For Android users, 

the section is titled Violations. 

2. Tap Violations to view existing related violation records or create new ones. 

 Note: For Android users, under Violations, you can select View to see all existing records 

or select New to add a new record. 
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The panel shows a button to add a violation as well as a list of violations related to the inspection you've tapped. Since 

there aren't any violations yet, none are listed. 

3. Tap Add. 

 Note: For Android users, tap New. 

A form containing the fields in the Violations table opens. 

4. Fill out the four fields (it doesn't matter what you enter). 

 

 
5. Tap Submit. 

 Note: For Android users, tap the checkmark button to submit the violation. Then, tap View 

to review the submission. 

You see the new violation as well as information about the inspection and hydrant to which it is related. 

 
In this lesson, you enabled a fire hydrant inspection process from a paper form to a digital one. First, you create a web map in 

your ArcGIS Online organization. Then, you opened the web map in Collector for ArcGIS and added a test inspection and 

violation. The inspection you added was automatically updated to the web map. You can access the data through both 

Collector and the original web map in your ArcGIS organization. 

You can find more lessons in the Learn ArcGIS Lesson Gallery… learn.arcgis.com/en/gallery. 

http://learn.arcgis.com/en/gallery/
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Oversee Snowplows in Real Time Overview 

During blizzards, drivers can become downright impatient before roads are cleared of snow; after all, they must get their 

children to school and themselves to work. In this lesson, as a GIS coordinator in Utah, you're going to create two apps 

providing real-time locations of a city's snow removal fleet. One app is for residents, who need current information about road 

clearing. The other app is for city officials, who need additional information to manage ongoing operations. Both apps contain 

real-time data tailored to the needs of their intended users. 

• Publisher or Administrator role in an ArcGIS organization (get a free trial) 

• Operations Dashboard for ArcGIS 
 
 

 

https://www.esri.com/en-us/arcgis/trial
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Create a real-time web map 

The first step to creating your real-time apps is to make a web map with the necessary real-time data. The city's public works 

department already collects real-time data on its snowplow fleet using automatic vehicle location (AVL) devices. These devices 

are installed on each snowplow and transmit GPS coordinates from the vehicle to a receiver at the city office. You'll add this 

data to a web map and symbolize and label it appropriately to clearly communicate important information to users. 

Add real-time data 

The local government's real-time feature layers are updated periodically by ArcGIS GeoEvent Server, which connects real-time 

data streams (such as those transmitted by the AVL devices in each snowplow) to feature services hosted on ArcGIS Online 

and ArcGIS Enterprise. You'll add each of the three real-time feature layers to a new web map. 

 Note: This lesson won't go into detail about how to create real-time feature services using 

GeoEvent Server. You can learn more with the tutorials provided in the ArcGIS 

GeoEvent Server Gallery. 

1. Sign in to your ArcGIS organizational account. 

 Note: If you don't have an organizational account, you can sign up for an ArcGIS free trial. 

 

2. At the top of your organization home page, click Map. 

 

 
A new map opens. The map extent for a new map is set to the default extent of your organization. Next, you'll search for 

and add the city's three real-time layers involving snowplows and streets. 

 Note: If you're in a new ArcGIS Online session, clicking Map opens a new map. Otherwise, it 

opens the last map you were using. If an existing map opens, click New Map in the 

upper right corner of the page and choose Create New Map. 

3. On the ribbon, click Add and choose Search for Layers. 

 

 
The Search for Layers pane appears. 

4. In the Search pane, click the My Content drop-down arrow and choose ArcGIS Online. Search for “Street Plowed 
Status_Workshop2020” layer owned by hmiller_esridenver. 

http://links.esri.com/geoevent-gallery
http://links.esri.com/geoevent-gallery
https://www.arcgis.com/home/signin.html
http://links.esri.com/arcgis-free-trial/
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5. Click the + button to add the layer to your  map. 

 
This layer contains features that represent major streets in the area. Each street is symbolized based on whether it has 

been plowed (green), has not been plowed (red), or is in progress of being plowed (yellow). Although the features look like 

lines, they are actually polygons. To detect whether a snowplow has entered or exited a particular street section, the 

original street centerline data was buffered with a chosen distance. That way, even if a snowplow isn't located on the exact 

center of each street, it'll still register as having been on the street. The buffers were added to GeoEvent Server as 

geofences, or geometric boundaries that trigger a response if something enters their area. In this case, streets are marked 

as either plowed, not plowed, or in progress, depending on whether snowplows have crossed or are currently crossing the 

geofences. 

 

6. In the Search for layers dialog box, type Vehicles (Past)_Workshop2020 in the search box and press Enter. Find 

the layer owned by hmiller_esridenver.



Oversee Snowplows in Real Time 

Copyright © 1995-2019 Esri. All rights reserved. 7 

 

 

 
 

 
 

 
 

The search returns the Vehicles (Past)_Workshop2020 layer.  

7. For the Vehicles (Past)_Workshop2020 layer, click the + Add button. 

 

 
 Note: Depending on your browser window, you may need to zoom out to see all the 

vehicles located in the White city area of Utah. 

The vehicles are represented by colored triangles. Orange triangles represent snowplows, and blue triangles represent 

pickup trucks with plows attached. Each of the nine vehicles has a corresponding symbol on the map.  

8. In the Search pane, change the search string to Vehicles (Latest)_Workshop2020 press Enter. This layer contains 

point features that will display the latest recorded location of each snowplow. When the snowplows change 
locations, their AVL devices transmit their GPS coordinates to GeoEvent Server. Once the layer is configured 
appropriately, it will automatically update with the newest coordinates. 

9. From the search results, choose Vehicles (Latest)_Workshop2020 owned by hmiller_esridenver, and click the Add button. 
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The vehicles are represented by colored circles. As before, orange represents snowplows, and blue represents pickup 

trucks. 

10. In the Search pane, click the Back button. If necessary, click Contents to display the layers you just added to the map 

The Contents pane appears. It lists all three layers currently on the map. The Streets Plowed Status layer doesn't show up 

well on the current basemap, so you'll change the basemap to one with a darker color scheme. 

11. On the ribbon, click Basemap and choose Dark Gray Canvas. 

 

 
The Streets Plowed Status layer appears more clearly on the map. 
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Your layers have been added, but the temporal component of each layer is inactive. Although these layers were specifically 

prepared using GeoEvent Server to contain live data streams based on each snowplow's AVL device, the data will not 

update on the map because a 0.01 second refresh interval has been set. 

12. On the ribbon, click Save and choose Save As. 

13. Save your map using the following information: 

• For Title, type Snowplows in a Utah City 

• For Tags, type Snowplows, Roads, Utah 

• For Summary, type This map shows the real-time location of snowplows in a city in 
Utah. 

 
Your map is now complete. It shows the location of snowplows and the status of roads throughout the city. The data layers 

update in real time at an interval of 6 seconds, and the features are symbolized to clearly communicate important information 

to the user. 
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Create a dashboard 

Previously, you accessed a web map using real-time layers showing the current location of snowplows throughout the city. 

The map also indicated whether roads were plowed. While the map contains vital data for both citizens and government 

officials, city officials require a dashboard that can be used for internal purposes to monitor snow removal operations. The 

dashboard must provide the following information: 

• A list that updates in real time with vehicle names, speeds, and the last time their location was updated 

• A bar chart that updates in real time with vehicle speeds 

• A pie chart that updates in real time with proportions of street plowed status 

• A list that shows street names and plowed status 

This information will help local officials organize the routes of snowplows and monitor snow removal operations throughout the 

city. You'll create a type of dashboard using Operations Dashboard for ArcGIS. Dashboards are fully configurable and can 

include elements that display maps, lists, and charts. In this lesson, you'll install the free Operations Dashboard for ArcGIS and 

use it to combine your web map with the information the city officials require. 

Add your map to an operation dashboard 

First, you'll choose a map for your dashboard to use. 

1. Sign in to your ArcGIS Online account. 

2. Click Content, click the App Launcher, and choose Operations Dashboard. 

 

 
The Operations Dashboard home page appears, where you can create, edit, and view dashboards. 

3. Click Create Dashboard. 

The Create new dashboard pane appears. 

4. In the Create new dashboard pane, do the following: 

• For Title, type Snowplows in a Utah City. 

• For Tags, type Learn. 

• For Summary, type The location of snowplows and the status of roads in a city in Utah. 

• For Folder, select a location to store your dashboard. 
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5. Click Create Dashboard to generate your new dashboard app. 

Now that you've created your dashboard, you can add elements. In the next steps, you'll add the following elements: 

• Map 

• List 

• Serial Chart 

• Pie Chart 

6. In the Snowplows in a Utah City setup pane, click the Add button to access the elements drop-down list. From the list, 

choose Map. 

 

 
The Select a map pane appears and lists the web maps that are available to your ArcGIS account. 

7. Browse to the Snowplows in a Utah City web map. Click Select to add the map as an element to your operation 

dashboard. 

The web map's content will serve as the data source for the other elements. 

 

 
The Configure Map window appears. 

8. On the Settings tab, click the toggle buttons to enable the following options: 

• Pop-ups 

• Default Extent and Bookmarks 

• Layer Visibility 

• Basemap Switcher 

• Search
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These capabilities will allow users to navigate the map effectively, as well as select features of interest and gain more 

information through pop-ups. 

9. Click Done 

The dashboard appears with the map elements you just configured. 

 

 
On your own, explore the layout and click a truck to view a pop-up displaying the vehicle's properties. 

 
Add elements 

You've configured your map element and taken advantage of some of the real-time functionality of Operations Dashboard to 

make your map communicate information even more clearly. As mentioned at the beginning of this lesson, the city authorities 

want to have easy access to some additional information about the snowplows. In particular, they're interested in a list of 

information about each vehicle, as well as charts they can use to compare information between vehicles or streets. They also 

want a list of street names with plowed status. To provide this information, you'll configure three elements and arrange them on 

your map. 

1. On the ribbon, click the Add button and choose List.
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Now, you'll configure the list to display the speed of each of the nine vehicles in the fleet. This information will be used to 

monitor the vehicles that are currently plowing and how fast they are traveling. 

2. In the Select a layer pane, choose Vehicle(Latest). 

 

 
The List configuration pane changes to display data options for the Vehicle(Latest) layer. 

 

 
By default, vehicles are listed in order by their ObjectID, a field in ArcGIS that internally organizes features in a layer. You'll 

change this to list the trucks in order by their vehicle name. 

3. In the Data Options pane, for Sort By, click +Sort, choose vehiclename, and click Ascending. 
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The preview on the right side of the window indicates that the vehicles are now listed in order by their name. Next, you'll 

add the speed of each vehicle to the list. As with the time field you used to create the filter, the AVL devices also record 

vehicle speed for each snowplow. The speed information is also included in the layer. 

4. Click the List tab, click the field drop-down arrow, and choose the vehiclename field. 

5. Repeat step 4 to add the speed field to a separate line. 

 

 
The list preview now includes the speed of each vehicle in miles per hour and is displayed to the right of the list options 

pane. 

 

 
6. Click the Actions tab, click the Add Action drop-down arrow, and choose Follow Feature. This will result in the display of 

a breadcrumb trail as the vehicle moves along the roads on the map. 

 

 
7. Click the General tab, and in the General Options pane, for Title and Description, do the following: 

• Click Edit for Title, and type Vehicles in the text pane. 

• Click Edit for Description, and type Speed in miles per hour in the text pane. 

• Use the formatting options to center the title and make it bold. 
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After making these changes, the title will be placed at the top of the list and the description at the bottom. 

8. Click Done. 

The list element is added to the dashboard. You can drag the list and dock it anywhere. 

 

 
9. Drag the list element and dock it to the right of the map element. Adjust the width of the list element so it doesn't take up 

any more space than necessary. 

 

 
 Note: To adjust the size of an element, point to the edge of the element and drag it to the 

desired size. 

Having the vehicles speeds visible is good, but you can make the information clearer by adding a bar chart that shows the 

speeds relative to one another. 

10. Click the Add button and choose Serial Chart. 

11. In the Select a layer pane, select Vehicles(Latest). 

12. Click the Data tab. 

13. In the Data Options pane, change the following parameters: 

• For Categories From, click Features. 

• For Category Field, choose vehiclename. 

• For Series 1 Field, choose speed. 
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• For Sort By, choose vehiclename, and click Ascending. 

 

 Note: If you have a blank value in your data, you can remove the null information from the 

chart using the vehiclename is not empty filter option. 

 

 

The preview shows a bar chart with nine bars, one for each vehicle. However, the axis labels do not indicate the values that 

the bars represent. 

14. Click the Category Axis tab, and for Title, type Vehicle. 

15. Click the Value Axis tab, and for Title, type Speed. 

16. Click the Series tab, scroll down to the Bar Colors option, and change the color to blue with the Hex code #00c5ff. 

17. Click the General tab, and in the General Options pane, change the following parameters: 

• In the Title text box, type Vehicle Speed. Center align the title text. 

• Above the text box, click Normal, and choose Heading 2. 

18. Click Done. 

19. Drag the bar chart element and dock it under the list element. If necessary, resize the elements so that all information is 

displayed clearly. 

 

 
Next, you'll add an element that shows the status of streets as a pie chart. This element will allow city authorities to see at a 

glance the proportion of streets that have been plowed compared to those that haven't been plowed. It'll function as a 

progress meter for the plowing operation. 

20. Click the Add button and choose Pie Chart. 

21. In the Select a layer pane, for Data Source, choose Street Plowed Status. 

To display a percentage of streets plowed, you'll display the count of features for each plow status. 

22. Click the Data tab. 

23. In the Data Options pane, change the following parameters: 
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• For Categories From, ensure that Grouped Values is selected. 

• For Category Field, choose PlowedStatus. 

The preview updates and shows a pie chart with two or three sections (it possible that there are no In Progress streets). 

You'll update the chart's appearance to add a legend and change the color scheme. 

 

 
24. Click the Chart tab. 

25. In the Chart Options pane, do the following: 

• For Labels Visibility, click Hide. 

• For Legend Visibility, click Percentage. 

 

 
26. Click the Slices tab, click Apply Colors, and choose your own colors or accept the default color settings. 

27. Click the General tab, and for Title, type Streets Plowed Status(Percent). 

Now you'll enable the pie chart with feature actions so users can view streets of a certain status using the chart 

28. Click the Actions tab. 

29. In the Actions pane, change the following parameters: 

• In the Actions pane, click Add Target and choose Streets Plowed Status. 

• For Filter, choose Add Target. 

• Choose the Streets Plowed Status layer as the target of the action. 

30. Click Done. 

31. Drag the pie chart element and dock it on the right side of the dashboard. If necessary, resize the list and bar chart 

elements to display all information clearly. 
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32. To use the feature actions you enabled, click one of the pie chart segments and note how the map layer filters the streets 

based on your selection. 

The pie chart element contains a lot of empty space. You'll use that space to contain the final element that you create. This 

element will be another list element that displays the names of streets and their plowed status. 

33. On the ribbon, click the Add button and choose List. 

34. In the Select a layer pane, choose Street Plowed Status. 

You want the list to display the plowed status of streets, so you'll change the lists settings appropriately. You'll also increase 

the maximum number of items that can be displayed in the list to display many streets at once. 

35. Click the Data tab. 

36. In the Data Options pane, change the following parameters: 

• For Maximum Features Displayed, set the value to 50. 

• For Sort By, choose PlowedStatus, and click Ascending. 

The preview updates with a list of streets, each with a symbol indicating the plowed status. To make the list more clear, 

you'll add a description to each list item that states the plowed status explicitly. You added a similar description to the list of 

truck speeds earlier. 

37. Click the List tab. 

38. In the List Options pane, click the field drop-down arrow, and choose the StreetName and PlowedStatus fields. Add the 

fields on separate lines. 

 

 
As with your pie chart, you'll enable certain feature actions for the list so users can use it to navigate or highlight specific 

streets of interest. 

39. Click the Actions tab. 

40. In the Actions pane, change the following parameters: 

• Click the Add Action drop-down arrow and choose Zoom. 

• In the Zoom action, click Add Target, and choose the Snowplows in a Utah City map as the target. 

41. Click the General tab. 

42. In the General Options pane, change the following parameters: 

• For Title, type Streets Plowed Status (Street Name). 

• Choose Heading 2 for the formatting style. 

43. Click Done. 

44. Dock the list element under the pie chart element and adjust the sizes of each element to minimize empty space. 
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Spend a few minutes exploring your newly configured operation dashboard. Then, add a header to it. 

45. From the Add menu, choose Header. 

The header defaults to the title of the map. 

46. Click Done. 

 
Save and share your dashboard 

Your dashboard is now configured with the necessary elements. Next, you'll save your dashboard and share it with the 

appropriate people. 

1. On the ribbon, click Save. 

2. Click Home, and click Dashboard Item Details. 

 

 
You can either share your dashboard with members of your organization or with everyone. Because this operation view is 

meant for use by city authorities and not the public, you'll only share it with your organization. 

3. On the Overview tab of the Snowplows in a Utah City item details page, click Share. 

 

 
4. In the Share pane, select the check boxes next to your organization's name and everyone, and click OK. 
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When you share the dashboard, any associated maps will need to be shared in the same way. You can access the shared 

dashboard through both the Operations Dashboard for ArcGIS application or via an ArcGIS Online account. 

 
You've used your web map to create a dashboard that city officials can use to efficiently track and manage their snow plow 

operations. In particular, you added lists and charts showing streets and vehicles. 
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In this lesson, you created a map and operations dashboard for both city officials and citizens that can be used to monitor the 

status of snow removal operations throughout the city. First, you created a web map containing real-time data layers. Next, 

you used that web map to create a dashboard that enables city officials to track snowplows and street status. These maps and 

apps will help keep the citizens safe and provide real-time information to decision makers. 

You can find more lessons in the Learn ArcGIS Lesson Gallery. 

http://learn.arcgis.com/en/gallery/

